
 
Advanced Presentation Options 

  

Introduction 
There are many things to keep in mind when giving a presentation. How long 
will your presentation last? What will you say? If you're not in the same 
location as your audience, how will they view it? Fortunately, PowerPoint 
2010 offers a number of tools to help you ensure that your presentation goes 
smoothly. 

In this lesson, you will learn how to Rehearse and Record slide shows in 
advance. You will also learn about alternative presentation options, such as 
creating a video of your presentation or broadcasting your presentation to 
remote audiences. Finally, you will learn how to create handouts of your 
presentation or customize it with hidden or rearranged slides.  

  

Rehearse and Record Slide Shows  
PowerPoint 2010 offers you two useful options for rehearsing and 
preparing the timing and delivery of your presentation in advance: 
Rehearse Timings and Record Slide Show. 

Watch the video to learn how to rehearse timings, record 
narration, and use the laser pointer in your presentation.  

  

 Rehearsing Slide Show Timings 
Rehearsing timings can be useful if you want to set up a presentation to play at a certain speed without having 
to click through the slides to present it. Think of it as a tool to help you practice presenting your slide show. 
Using this feature, you can save timings for each slide and animation. PowerPoint will then play back the 
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Watch the video (3:06). Need help? 
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presentation with the same timings when you present it.  

To Rehearse Timings: 
1. Select the Slide Show tab and locate the Set Up group. 

2. Click the Rehearse Timings command. You will be taken to a full screen view of your presentation.

3. Practice presenting your slide show. When you are ready to move to the next slide, click the Next button on 
the Recording Toolbar in the top left corner. If you prefer, you can also use the right arrow key.

4. When you have reached the end of the show, press the Esc key to end your slide show. A dialog box will 
appear with the total time of your presentation.

5. If you are satisfied with your timings, click Yes. 

The Rehearse Timings command 

Navigating to the next slide 
using the Recording toolbar 

Verifying the new slide timings 
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If you need more than one try to get the timings just right, the Recording Toolbar has options to let you take a 
break or start over on a slide. To pause the timer, click the pause button on the toolbar. No actions taken while 
the timer is paused will be included in the timings. To re-record the timings on the current slide, simply click the 
repeat button. 

  

Recording Your Slide Show 
The Record Slide Show feature is similar to the Rehearse Timings feature, but more comprehensive. If you 
have a microphone for your computer, you can even record voice-over narration for the entire presentation. 
This is useful if you plan on using your slide show for a self-running presentation or a video. Your mouse won't 
show up on screen in recorded slide shows, so if you would like to point out details on screen, you can use 
PowerPoint's laser pointer option.  

To Record a Slide Show: 
1. Click the Slide Show tab and locate the Set Up group. 

2. Click the Record Slide Show drop-down arrow.

The Recording toolbar 
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3. Select either Start Recording from Beginning or Start Recording from Current Slide. The Record 
Slide Show dialog box will appear. 

4. Select the desired options. Remember, you can only record narration if you have a microphone attached 
to your computer.

5. Click Start Recording. Your presentation will open full screen.  

6. Perform your slide show. Make sure to speak clearly into the microphone if you are recording narration. 
When you are ready to move to the next slide, click the Next button on the Recording Toolbar in the top 
left corner or use the right arrow key.

7. When you reach the end of the show, press the Esc key to exit.  

8. Your slide show timings and narration are now included in your presentation. The slides with narration will 
be marked with a speaker icon in the bottom right corner. 

The Record Slide Show command 

The Record Slide Show dialog box 

Navigating to the next slide 
using the Recording toolbar 
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To point out details during your recording, press and hold the Ctrl key on your keyboard. Your cursor will show 
up as a laser pointer. Simply move your mouse to indicate the desired details. Release the Ctrl key when you 
are finished pointing out things on screen. 

  

To Remove Narration or Timings from a Recorded Slide Show: 

Slides with narration 

Using the laser pointer 
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1. Click the Slide Show tab and locate the Set Up group. 

2. Click the Record Slide Show drop-down arrow. 

3. Hover your mouse over Clear.

4. Select the desired option. 

  

  

Sharing Presentation Options 
PowerPoint 2010 offers several options to enhance or even 
totally change the way you deliver presentations. Instead of 
presenting your slide show normally, you can choose to present it 
as a video, or even broadcast it live on the Web so that others 
can view it remotely. No matter how you choose to give your 
presentation, you can enhance it by customizing your slide show 
to remove or reorder slides, or printing handouts to help your 
audience take notes. All of these options can help you give a 
polished and professional presentation. 

Watch the video to learn about the various ways you can 
share and deliver your presentation, including creating a 
video, broadcasting your presentation remotely, and printing handouts.  

  

Presenting Your Slide Show as a Video 

Clearing timing on all slides 
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Watch the video (4:22). Need help? 
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The Create a Video feature allows you to save your presentation as a video. This can be useful, as it lets your 
viewers watch the presentation whenever they like. To make sure your viewers have enough time to view each 
slide, you might want to rehearse the timings or record your slide show before using this feature. 

To Create a Video: 
1. Click the File tab. This takes you to the Backstage view. 

2. Select Save and Send. 

3. Select Create a Video under File Types. The Create a Video menu will appear on the right.

4. Click the drop-down arrow next to Computer and HD Displays to select the size and quality of your 
video.

Creating a video in the Save and Send tab 
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5. Select the drop-down arrow next to Recorded Timings and Narrations.
» Choose Don't Use Recorded Timings and Narrations if you don't have or don't wish to use 

recorded timings. You can adjust the default Seconds to spend on each slide: in the box below 
the drop-down menu. 

» Choose Use Recorded Timings and Narrations if you have already recorded timings and 
narrations and would like to use them in your video. 

6. Click the Create Video command. The Save As dialog box will appear.  

7. Select the location where you wish to save the presentation, then enter a name for the presentation. 

Selecting video size and quality 

Selecting recorded timings and narration 
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8. Click Save. A status bar will appear in the bottom right corner of the PowerPoint window as PowerPoint 
creates your video. When the bar is completely green, your video is ready to view, send, or upload.

In addition to emailing your video, you can also upload your video to free video sharing sites like 
YouTube.com. YouTube offers guides to creating an account and uploading videos. Once your video is 
uploaded, you can simply give the link to anyone you want to see it.  

Saving the video 

The status bar making the time until the video is complete 
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Broadcasting Your Slide Show to Remote Audiences 
Broadcasting a presentation remotely is surprisingly easy. All you and your viewers need is an internet 
connection-- they don't even need PowerPoint. Once your viewers are connected, you can start the presentation 
as you normally would.  

Please note that you cannot edit your presentation or mark it with a highlighter or pen while you are 
broadcasting a slide show. You also cannot use PowerPoint to speak to your audience. Plan to 
communicate with your viewers through teleconferencing, or pre-record your narration. 

The finished video uploaded to YouTube 
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To Broadcast a Slide Show: 
1. Select the Slide Show tab and locate the Start Slide Show group. 

2. Click the Broadcast Slide Show command. The Broadcast Slide Show dialog box will open.

3. Click Start Broadcast. A status bar will appear as PowerPoint prepares your broadcast.

The Broadcast Slide Show command 

The Broadcast Slide Show dialog box 
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4. A link will appear. Select the link, and click Copy Link to make a copy of the link, or Send in Email to 
send an email with the link to your viewers.

5. Click Start Slide Show. 

6. Present your slide show. 

7. When you are finished, click End Broadcast in the yellow bar at the top of the screen.

  

Copying the link for the broadcast 

Ending the broadcast 
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Customizing Your Slide Show 
Sometimes you might want to hide a slide while still keeping it in your presentation. For instance, if you are 
presenting a slide show to more than one group of people, hiding or even rearranging certain slides could help 
you tailor your slide show to each group you present it to. You could also choose to create a shortened version 
of your slide show to present when you're short on time. The Custom Slide Show feature allows you to create 
and name different versions of your slide show with hidden or rearranged slides. 

To Create a Custom Show: 
1. Select the Slide Show tab and locate the Start Slide Show group. 

2. Click the Custom Slide Show command.

3. Select Custom Shows.... The Custom Shows dialog box will appear. 

4. Click New. The Define Custom Show dialog box will appear.
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The Custom Slide Show command 
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5. Locate the Slide show name box and type in a name for your custom show. 

6. Select the slides in the Slides in presentation: box that you would like to include in your custom show, 
then click Add>> to add them to the Slides in custom show: box. If necessary, use the up and down 
arrows to reorder the added slides.

7. Click OK. 

8. Select Close to exit or Show to view your custom show. 

Creating a new custom show 

Adding slides to the custom show 
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You can also hide slides by selecting the Hide Slide command, which can be found on the Slide Show tab. To 
unhide a slide, simply click the Hide Slide command again. 

 

Creating Handouts of a Presentation 
Printing handouts with images of your slides can be helpful to your audience, as it gives them a hard copy of 
the information you're presenting. Plus, they can take notes on the handouts as you present your slide show. 

To Create Handouts of a Presentation: 
1. Click the File tab. This takes you to the Backstage view. 

2. Click Print. 

Closing the Custom Show dialog box 

The Hide Slide command 
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3. Click the drop-down arrow in the box that says Full Page Slides, and locate the Handouts group. 

4. Select a page layout for your handouts. Up to nine slides can be displayed per page. Note that the 3 slides 
layout offers lined space for your viewers to take notes.

The Print tab in the Backstage view 
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5. Click the Print command.

If you would like to add a header or footer to your handouts, click the View tab on the Ribbon, then select 
Handout Master. Just type your header or footer information into the boxes provided. To return to the normal 
view, click Exit Master View.  

Selecting a handouts layout 

Printing the handouts 
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Challenge! 

 

The Handout Master View command 
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1. Open an existing PowerPoint presentation. If you want, you can use this 
example. 

2. Use the Rehearse Timings feature to record slide and animation timings for 
the presentation. Or, if you have a microphone attached to your computer, use 
the Record Slide Show feature. 

3. Create a custom slide show from your presentation. 

4. Create a video of your presentation. 
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